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Section 1  
Best Practices    

This section discusses the best practices that to derive optimum performance from 
the ClearPath OS 2200 IDE for EclipseTM software.  

The following list provides some of the best practices: 

 If you attempt to read or write a program file whose data area or TOC area has 
become saturated, Common Internet File System (CIFS) automatically attempts to 
pack that program file. To prevent packing of the program files, you can 

- Create program files with a size bigger than 256 tracks. 
 

- Create program files with a large number of Large Program File (LPF) 
elements. 

 
- Run program files that are permanently assigned to you so that CIFS cannot 

pack these program files.  
 
Note: You can perform a common background run to identify a list of files 
that need to be permanently assigned during the peak usage of OS 2200 IDE 
for Eclipse. If you perform this action, you cannot manually pack the 
program files unless they are withdrawn from the background run. 
 

   Monitor the Eclipse Heap size continuously. Ensure that the heap status is always 
enabled. Refer to Section 2, “Monitor Heap” for more information. If the available 
heap memory is low, close a few editors that are not in use and run the Garbage 
collector. To run the Garbage collector, use the following steps: 
 
1. Terminate any operation that involves large amount of data. For example, 

opening large files, copying or pasting text that is greater than 100000 lines, 
and so on. 
 

2. Click on the Garbage icon        in the Heap status bar. 
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3. Adjust the Free Memory Factor (FMF) and File Size Factor (FSF) available from 
OS 2200 menu> Configure Editor Scalability to avoid Eclipse running 
out of heap space. FMF and FSF are used to determine if an operation can be 
performed safely and these values are currently used to open a file. 

FMF is the ratio of Free Memory to Total Memory. By default, it is set to 20. 
FSF is the ratio of File size to the Free Memory. By default, it is set to 6. 
Setting a higher FMF value for example, to 30 and setting FSF value for 
example, to 20 ensures that Eclipse will never run out of heap space.  

Note: The probability of opening the files in an external editor is high if the 
FMF and FSF are set to higher values.   

   Use one of the following values to set the value of the JVM Heap, in the same 
hierarchy as eclipse.exe: 

Xms256m –Xmx512m –XX:MaxPermSize=256m for 2GB RAM on 32-bit Operating System 

Xms512m –Xmx768m –XX:MaxPermSize=256m for 4GB RAM on 32-bit Operating System 

Xms512m –Xmx1024m –XX:MaxPermSize=256m for 4GB RAM on 64-bit Operating System  

To configure the heap size, open the eclipse.ini file, located under <EclipseBase 
directory>, locate the –Xms and –Xmx entries, and replace them with one of the 
JVM heap values.  

Note:  While starting Eclipse it requires a contiguous block of memory set in 
the –Xmx option. If the Eclipse process fails to block the contiguous block, 
then Eclipse fails to start. Under such circumstance, reduce the value set        
in –Xmx option. The amount of reduction depends upon the memory that is 
available on the machine. Therefore, it is recommended to reduce it by 128MB 
chunks until Eclipse starts successfully. 

While opening large files (greater than 3 MB), use “Unisys Common Editor” if you 
want to force open a COBOL element. Ensure that the heap size of OS 2200 IDE 
for Eclipse is sufficient to perform this operation.  

      Perform the following steps to open a COBOL element in the COB Editor: 

1. On the File menu, click Open External File. 
 

2. Navigate to the location of the COBOL element. 
 

3. Select the COBOL element or any other large file. 
 

4. From the list of editors that OS 2200 Eclipse displays, select “Unisys 
Common Editor” to open the file. 
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   To establish a CIFS connection, OS 2200 IDE for Eclipse depends on your 
workstation OS. Your workstation OS can be Windows XP, Windows Vista, or 
Windows 7. If the OS displays the connection as active, OS 2200 IDE for Eclipse 
uses the OS. You might have to disconnect the mapped network drive in a few 
instances before starting or restarting Eclipse 2200. If you need to connect to a 
host with different credentials, provide the Host Name for the first connection 
and provide the IP address to establish subsequent connection. This helps 
prevent the following error message. 





Eclipse 2200 supports both Host Name and IP address as the Host while adding a 
host.  

Microsoft Windows XP Operating System will be discontinued by Microsoft 
starting April 2014. As a result, Unisys will no longer support Windows XP. Unisys 
therefore strongly recommends you to use a qualified version of Windows 
Operating System in order to use ClearPath OS 2200 IDE for Eclipse. 

Note: Unless you have an explicit written contractual agreement with Unisys, 
Microsoft Windows XP will not be supported beyond April 2014. You must 
contact Unisys Support if you wish to enter into an agreement with Unisys to 
get the support for Windows XP. 

   When you use the OS 2200 IDE for Eclipse debugger with OS 2200 programs, 
ensure a clean program file as the destination output for the object modules 
created for debugging the programs. You can delete the contents of the program 
file or create a new program file while compiling the program for debugging. 
 

   OS 2200 IDE for Eclipse depends on the network speed to open or save OS 2200 
files and elements. If the network bandwidth is slow, OS 2200 IDE for Eclipse 
does not respond until the element is opened or saved. OS 2200 IDE for Eclipse 
requires between 6 to 17 minutes for opening an element of 700K lines, with text 
varying from 1 to 50 characters per line on an average network bandwidth. This 
ability of OS 2200 IDE for Eclipse is tested and verified on Unisys network 
bandwidth of 12 Megabyte per second/25 Megabyte per second (download or 
upload). This is also applicable while building the OS 2200 project.  

   If you need to perform a Copy-Paste operation on an element with 30K lines or 
more, drag and drop the elements of Copy-Paste instead of copying the 
contents. 

   Ensure that there is 4 Gigabytes of RAM on the workstation where OS 2200 IDE 
for Eclipse is running. 
 

   Using “OS 2200 File Explorer” to open files from an OS 2200 configured server 
supporting Multi-Host File Sharing (MHFS), ensure the following: 
 
-   Do not use the same file name over both the Master File Directories (MFDs). 

If the same file name exists in both the STD# and SHARED# MFDs, CIFS uses 
the first file found when creating the CIFS file system with no predictability 
on the file being used. 
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-   Though you can set the MFD# in the UNC path, while opening the files from 
the configured servers, refrain from using the MFD# in the UNC path. 
 

-   If you provide an incorrect MFD#, that is STD# instead of the correct 
SHARED# or vice-versa, unpredictable results in the UNC path might be 
generated. 
 

   When using OS 2200 IDE for Eclipse over a period of time, you might notice 
some unexpected behavior in your plugins. The following are some of the errors 
that you might see: 
 
-   When you click Search, search results are not displayed. 

 
-   Autocomplete process does not work or displays unexpected results.  

 
-   A newly installed plugin does not work as expected.  

Such preceding behaviors indicate that OS 2200 IDE for Eclipse and your 
workspace requires a clean-up. Use the following link to view information about 
the clean-up process: 

http://www.eclipsezone.com/eclipse/forums/t61566.html 

   If you use a new build of the OS 2200 IDE for Eclipse, ensure to use a 
corresponding new workspace. Perform steps 4 through 10 to import projects 
from the old workspace to the new workspace. To use a new build of OS 2200 
IDE for Eclipse with an existing workspace for the first time, perform the 
following steps: 
 
1.   Remove the .metadata folder from the existing workspace. You can either 

rename the folder and move it outside the existing workspace or delete the 
folder permanently. 
 

2.   Launch the new version of the OS 2200 IDE for Eclipse, and provide the path 
of the existing workspace. 
 

3.   Click OK. 

      OS 2200 IDE for Eclipse displays a new workbench. 

4.   Right-click the OS 2200 Explorer view and select Import. 

       Import dialog box is opened. 

5.   In the Import dialog box, click General menu and select Existing Projects 
into Workspace. 
 

6.   Click Next. 
 

7.   On the Import Project page, click Browse and type the path from where you 
deleted the .metadata folder. 
 

http://www.eclipsezone.com/eclipse/forums/t61566.html
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8.   Click OK. 

      All the projects in the selected path are displayed in the Projects pane. 

9.  Click Finish in the Import dialog box. 

      All the projects are listed in the OS 2200 Explorer View. 

10. Close all the imported projects and open the projects that you want to work 
on. 

Note: If you are using a new workspace with the new build of OS 2200 IDE for 
Eclipse, then you do not need to perform steps 1 through 10. 

   OS 2200 Projects view and OS 2200 File Explorer view can be best used for the 
following: 
 
-   OS 2200 Projects are persistent and can be referred over and over again. You 

can use OS 2200 Project for building and debugging the projects, outline view 
for the editors, tool tip within the opened editors, or simply want the 
elements to be listed for future reference. 

 

You can use OS 2200 File Explorer to browse through the files or elements and open 
those for viewing, editing, and saving. OS 2200 File Explorer can be used for viewing 
and editing the data files and is capable of browsing the non-standard OS 2200 files.
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Section 2  
Product Interdependencies    

Perform the following steps to enable the heap status: 

1. On the Window menu, click Preferences from the Window menu. 
 

2. In the Preference dialog box, select the General option on the left and then 
select Show the heap status check box under General category in the 
right pane.  
 

3. Click Apply and then click OK.  

    The Heap status appears on the Heap status bar. 

 

To run the Garbage collector, click the Garbage icon on the Heap status bar . 
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Section 3  
Migration from Windows XP to 
Windows 7 and later  

Due to security improvements in Windows 7 and later, NTLM v2 is used to 
authenticate the credentials with an OS 2200 system. Unlike NTLM v1 used by 
Windows XP, NTLM v2 does not automatically convert CIFS passwords to uppercase 
automatically. Therefore, passwords are case-sensitive.  

While migrating from Windows XP, users must enter the password in the same case 
as used by the OS 2200 administrator while creating a password. By default, 
passwords are in uppercase on the OS 2200 system. 
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Section 4  
Limitations    

The following are the known limitations when using OS 2200 IDE for Eclipse: 

   OS 2200 IDE for Eclipse has a performance impact due to the following CIFS 
behaviors: 
 
-   Non-sequential I/O – When Eclipse receives or sends Input/Output (I/O) to or 

from a file/element, it is not absolutely sequential. The process of saving an 
updated element occurs in streams of bytes; after each write to the server, 
CIFS rewinds to the beginning of the memory allocation where the writing of 
the file had started. This process is called a backup and it is an overhead due 
to the Non-sequential I/O of CIFS. The backup duration depends on the length 
of the new file address. It can require half second per I/O call towards the 
end of saving a 43,000 line (3.1 MB) file due to the write-ahead. These 
overheads might affect the other concurrent OS 2200 IDE for Eclipse users, 
effectively denying them from CIFS 2200 file access during each backup. 
Eclipse 2200 has a performance impact due to this CIFS behavior. This 
limitation does not have any effect on Windows 7 because the CIFS protocol 
has been enhanced to SMB/CIFS 2.1 specification. 
 

-   Program files updated outside CIFS - If a program such as FURPUR, ELT, ED, a 
compiler, and so on updates a program file, then CIFS must reconcile the 
TOC of the program file with its internal directory when you want to open the 
program file with CIFS. CIFS might require one second or more to reconcile 
the directory of a 10,000 element program file with the TOC, and the effort is 
very CPU-intensive. When CIFS looks at a program file for the first time, CIFS 
must create its directory for the program file. Creating this directory can take 
up to three times longer than what is required when any program updates a 
program file on an OS 2200 system.  Only those users who are using the 
program file updated outside CIFS are affected. There is some additional OS 
2200 CPU usage due to the program file being updated outside CIFS. 
 

   The OS 2200 IDE for Eclipse project and file names must follow the naming 
conventions allowed by the workstation OS. 
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   OS 2200 project files and associated editors might fail to open automatically 
when OS 2200 IDE for Eclipse is started. Exclamation icons are placed on project 
files when this condition occurs. Closing and reopening the project might correct 
this problem. 
 

   Due to a bug in the Eclipse software, if you refactor or rename your OS 2200 
project name while in the Java perspective, Eclipse can throw a warning or error. 
To avoid this warning, these operations can be performed in the OS 2200 
perspective. Renaming the OS 2200 project in the Java perspective deletes the 
contents of the work file on the OS 2200 system and the files become local to 
your workspace. If you do not see the OS 2200 menu in the OS 2200 
perspective, try to reset the perspective. Use the Rest Perspective option in the 
Window menu to reset the perspective. If you want to update the existing 
Eclipse 2200 installation, Unisys highly recommends restarting OS 2200 IDE for 
Eclipse after the update operation is complete. 
 

   The concept of projects is the core to the existence of Eclipse as an IDE. There 
are many features in Eclipse that are project-dependent. Although ‘Open File 
from Configured Server’ (OFCS) feature can be used to open, edit and save )S 
2200 elements and data-files, there are a few features that do not work over the 
data-files and elements opened from OFCS because of the non-existence of 
project: 
 
-   Search All – If the user searches for an element using the Search-menu, all 

the instances of the search-string get listed in the Search-results. But the 
user can search within a file or element opened from OFCS with the 
search-string highlighted, one instance at a time. CTRL + K and CTRL + SHIFT 
+ K can then be used to jump to the next or previous instances of the 
search-string respectively. 
 

-   Compare to Previous version – The users can compare an element with its 
own previous-version within the project. The history is not maintained for the 
files or elements opened from OFCS, and therefore, this feature does not 
work over such files or elements. 
 

-   Compare with each other – The users can select a couple of elements from 
the OS 2200 projects and compare with each other. This is not possible for 
the files or elements opened from OFCS. 
 

-   Tool-tips – When the user places the mouse over a keyword, method or 
variable defined in an element opened in C-editor, the tool-tip shows 
additional information to the user. This information cannot be seen for the 
entities in a program opened in C-editor using OFCS. 
 

-   Outline-information – The outline-information can be viewed for the 
C-programs opened from the project. The programs opened from OFCS 
might display a blank outline-view. 
 

-   Build – Eclipse provides the ability to build the projects. The elements opened 
from OFCS cannot be compiled using the Eclipse options. 
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-   Debug – The elements opened from OFCS cannot be debugged interactively 
from Eclipse. 
 

-   COBOL Copy-Procs – The user can configure the COBOL copy-procs for the 
configured hosts. When the user places the mouse over a copy-proc in the 
COBOL program, the user can see the fully-qualified file-name for that proc in 
standard OS 2200 format. This information remains unavailable for the 
COBOL-programs opened from OFCS.  

It is recommended to create discrete and independent projects and include the 
elements that link to each other in terms of dependency. OFCS provides an ability 
to refer to the data-files or elements on the go. If the user wants to access the 
elements more often and wants to use the project-dependent features, it is 
recommended to create the projects for such elements. If the user wants to use 
the project-dependent features for the data-files, the user might Save-As those 
data-files to the OS 2200 project. 

 Eclipse-2200 IDE copies the elements that are included in the project into the 
cache on Windows Operating System since ClearPath 15.0 IC1 for performance 
improvements. For a workfile qualifier*filename. residing on the host, the folder 
structure for the cache will be  
<workspace>/data-cache/hostname/qualifier/filename. Due to limitations in 
Windows OS, you cannot create a folder/file containing the following filenames: 

- CON 

- PRN 

- AUX 

- CLOCK$ 

- NUL 

- COM[1-9] 

- LPT[1-9] 

Hence when Eclipse-2200 IDE tries to create the corresponding folder/file for the 
file/element respectively, creation of cache will fail. For example, PRN*CON. is a 
valid workfile name in OS 2200, but Eclipse cannot create a cache. 

 If the user uses Ctrl+S (or File -> Save) to save a New Text File, then the save 
operation is managed by base Eclipse. Under the Project folder, if the target folder 
is selected as the .settings folder and the user uses Ctrl+S (or File -> Save) to save 
a New Text File, then the elements are not saved in the OS 2200 host or the 
Project. Hence, the user must select Save As to Workspace or select the Project 
Folder (instead of .settings folder) for Ctrl+S option to save the New Text File 
successfully. 

 If a workfile contains two elements with the same name and of same type 
(example, COBOL), but one has version /COB and another does not, then only one 
of these elements must be included in the OS 2200 project. If both the elements 
are added to the project, then opening the element without version, removes the 
other element. 
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 If the user does not provide any extension for a new filename while performing a 
Save As to workspace, then by default Eclipse takes the extension from the 
source file and adds it. 

 Read/write keys cannot be used over network connections to CIFS because the 
protocol does not provide a means of specifying them. Therefore, the files with 
read/write keys cannot be operated from Eclipse. In other words, these files 
cannot be browsed from OS 2200 File Explorer and the users cannot create  
OS 2200 projects over these. Consequently, care must be taken on Fundamental 
Security systems to balance accessibility and vulnerability. It is strongly 
recommended to move to Security Option 1 or higher and using Access Control 
Records on files. 
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Section 5  
Rolled-out Files    

This Section discusses the special considerations for unloaded or rolled-out files 
depending upon the security-options. 

Fundamental Security 

 CIFS does not initiate a ROLBAK automatically. 

 Error status is returned to Eclipse and user gets an error dialog while opening 
the element from the project or Open-Files from Configured-Server feature. 

 Recommend CIFS$WAITROLBAK be set to 1; else, selecting the elements in 
the project-tree for a rolled-out file can get Eclipse to freeze. 

SECOPTn 

 CIFS initiates a ROLBAK automatically. (If not, CIFS has not been installed 
correctly. Please contact the OS 2200 administrator.) 

 CIFS waits until the earlier of the following two events.  

Note: Eclipse does not show any activity during this time. 

1. File is restored and CIFS then continues with Eclipse request, for example 
to open the file.  

2. CIFS$WAITROLBAK timer expires. Error status is returned to Eclipse and 
user gets an error dialog. 

 Recommend CIFS$WAITROLBAK in CIFS-BACK runstream should be set to 1. 
This avoids the Eclipse user to think Eclipse is “hung.” 

System profile should set CIFS$WAITROLBAK to default 600. This is for OS 
2200 batch and demand connections to CIFS. 

If other CIFS network connections require a longer CIFS$WAITROLBAK period, a user-
id profile should be created with the appropriate value. Please contact the OS 2200 
administrator for creating such a profile. 
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